Table of contents

INTRODUCTION.................................................................................................................................................. 4
HISTORY .............................................................................................................................................................. 4
SUMMARY ON STREAMING – WHAT AND WHY? ............................................................................................... 4
TECHNICAL DETAILS OF STREAMING: ............................................................................................................ 4
INSTALLATION AND CONFIGURATION .......................................................................................................... 5
HOW TO INSTALL AND PREPARE CODECS FOR STREAMING? ................................................................. 7
HOW TO START AND END STREAMING VIDEO AND AUDIO? ...................................................................... 7
DIFFERENCES BETWEEN VARIOUS STREAMING CLIENTS: ........................................................................... 10
‘MULTICAST’, WHAT IS IT AND WHY? ........................................................................................................... 10
FREQUENTLY ASKED QUESTIONS ABOUT STREAMING .................................................................................. 12
STREAMING ..................................................................................................................................................... 12
  What is ‘Streaming’? ...................................................................................................................................... 12
  What are the benefits of streaming? .............................................................................................................. 12
  Can I record a meeting and look at it later? ................................................................................................. 12
  What is ‘TTL/Router hops’? .......................................................................................................................... 12
  What is the ‘Port Setting’ in the menu? .......................................................................................................... 12
  What is ‘unicast’? ......................................................................................................................................... 12
  What is ‘multicast’? ...................................................................................................................................... 12
  Why does the old multicast address remain and not the new after an upgrade to B2 (or later) software? .... 12
  Why “Service not available. Disconnected” when trying to start a call while streaming? ................. 13
  Why “Cannot start streaming while in a call” when pressing “Start Streaming” while in a call? .......... 13
  Why do I get stream from the wrong codec? .............................................................................................. 13
STREAMING CLIENTS ....................................................................................................................................... 13
  Which streaming clients do TANDBERG streaming support? .................................................................... 13
  Where can I find the recommended streaming clients and what do they cost? ..................................... 13
  What do TANDBERG require from the streaming clients? ....................................................................... 14
  How to set up the streaming client, what do I have to do? ...................................................................... 14
  Can I start streaming directly from the streaming client? ....................................................................... 14
  Can I have more than one streaming client installed on my computer at the same time? ...................... 14
  Can I stream from several codecs to the same Streaming client? .............................................................. 14
  Can I stream to multiple unicast addresses? ............................................................................................... 14
  Why can’t I receive streaming with Internet Explorer 5.5? .................................................................... 14
  I have problems using a unicast address with RealPlayer. ..................................................................... 14
VIDEO .............................................................................................................................................................. 15
  What will I see and hear when I stream from a Videoconference? ............................................................ 15
  Why do I get blocks when I start streaming on my streaming client? ....................................................... 15
  Why don’t I get anything shown on my streaming client? ...................................................................... 15
  Why is the streamed image frozen? ........................................................................................................... 16
AUDIO ............................................................................................................................................................... 16
  I don’t have lip sync when I stream! What is wrong? .............................................................................. 16
  No Audio.................................................................................................................................................... 16
SECURITY .......................................................................................................................................................... 16
Can I know who is receiving the stream from my codec? ................................................................. 16
How do I prevent anyone from receiving the stream from my codec? .............................................. 16
How do I control who will be receiving the stream from my codec I? ............................................... 16
How do I control who will be receiving the stream from my codec II? ............................................. 17
How can I deny someone to receive the stream from my codec? ...................................................... 17
How to set Streaming Password? ....................................................................................................... 17
How many can receive the stream from my codec? ........................................................................... 17
How do I stop streaming? .................................................................................................................... 17

MORE STUFF ON STREAMING ............................................................................................................. 18

BACKGROUND ....................................................................................................................................... 18
TECHNOLOGY ....................................................................................................................................... 18
Packet-switched networks ..................................................................................................................... 18
Transferring multimedia on the Internet ................................................................................................ 19
Bandwidth and multicasting .................................................................................................................. 19
Network protocols .................................................................................................................................. 20
Introduction
This document is intended to provide help during installation and use of the Streaming functionality implemented in TANDBERG videoconferencing products. It is also intended to give some general background on what streaming is and how to make use of the feature.

History
Software version B1
First implementation of Streaming,
video H.261, 64kbps,
audio G.711, 64kbps,
available outside a call only,
local selfview is displayed as the streamed video.

Software version B2 & B3
Streaming video H.261, 16-320kbps,
streaming audio G.711, 64kbps,
streaming enabled outside and inside a call (TANDBERG 500/1000 outside a call only),
local selfview is displayed as the streamed video, and a mix of local and far end audio,
Session Announcement Protocol (SAP) implemented\textsuperscript{1}

Software version 4
Streaming video H.261, 16-320kbps,
streaming audio G.711, 64kbps,
streaming enabled outside and inside a call (TANDBERG 500/1000 outside a call only),
streamed video can be local video, far end video or voice switched,
streamed audio is a mix of local and far end audio,
streamed session can be password protected to ensure only authorized people listen in.

Summary on Streaming – what and why?
IP-based networks were originally not intended to transfer multimedia. They were purely designed for static content. Streaming technology is one way of dealing with the natural limitations multimedia on a packet-switched network suffers from. The key components that make this possible are:
• Buffering of data that to some extent compensates for the varying network conditions on a packet-switched network.
• IP Multicasting that allows several clients on a multicast enabled network to view the same media stream without sending several copies of the data over the network.
• Network protocols like RTP and RTCP, which allows for better control of the streaming media.

Streaming from TANDBERG codecs is allowed both inside and outside a video or telephone call. Streaming is used for sending audio and video data from one videoconferencing system to one or several PCs. Rather than having to wait a long time to download data, recipients can watch audio

\textsuperscript{1} Implemented in B3.1.
and video from the videoconferencing systems in real time, right on their own desktops. This allows people to watch a live video presentation and listen to discussion between two sites that are in a video or audio meeting.

Streaming is a good way for one or few people to send information to a large audience. The audience can remain seated at their own desk and they can easily resume their regular activities after the streaming session is over or even during the session if necessary.

**Intranet**
When using streaming on a corporate Intranet, it is of great importance that the streaming data being sent over the network doesn’t interfere with the rest of the network applications. This will slow down other traffic dramatically. To prevent this, IP multicasting is recommended, thus sending only sending one stream of data onto the network. The users are simply instructing the computer’s network card to listen to a particular IP address for the multicast.

**Internet**
Although streaming is conceivable over the Internet, streaming to a wide different variety of viewers on various parts of the Internet reliably is a very daunting task due to the variety in how people are connected and the quality and number of streams that would have to be created. In addition, the support for Multicast on the Internet is very limited. Streaming on very low bitrates (<64kbps) results in smaller video windows with lower frame rate, lower resolution, and poor audio quality.

**Technical details of Streaming:**

**Supported Audio standard.**
Audio standard supported G.711, 64kbps

**Supported Video standard.**
The video standard H.261 is still used as very few clients are currently supporting H.263 yet.
Video rate is 16kbps, 32kbps or any multiple of nx64kbps (where n is max 5 => 320kbps). Audio rate at 64kbps is in addition to the video rate and makes a total up to 384 kbps.

**Framerate**
The framerate is the same as if the connection was made on ISDN lines i.e. the same processing power is processing the streaming image as the regular videoconference. So any streaming rate over 192kbps, the source framerate will be up to 30fps, while below 192kbps video rate, the source framerate will be lower. The viewable framerate will depend on the quality of the data stream received by the viewing client.

**Codec features enabled/disabled while streaming**
MultiSite™ and Duo Video™ functionality is disabled while streaming, the fault messages “Cannot start streaming in a MultiSite/Duo Video call.” and “Cannot start streaming while in a call.” (for TANDBERG 500/1000) will explain the situation.

Streaming from a telephone to video call (point to point) is possible where the local selfview and the mix of both audios will be streamed.

Error messages while streaming:
"Streaming active, no call possible." For the TANDBERG 500/1000 and "Streaming active, no more calls possible." When a TANDBERG 800/2500/6000/7000/8000 is streaming.

**Supported Streaming clients**
Cisco IP/TV, QuickTime version 4 or greater, RealPlayer version 7 and VIC
Cisco IP/TV http://www.cisco.com
QuickTime version 4² or greater http://quicktime.apple.com
VIC http://www-mice.cs.ucl.ac.uk/multimedia/software/vic/
RealPlayer7 or greater http://www.real.com

**SDP file**
When streaming, the codec will generate a SDP file 'stream.sdp' which can be retrieved through the codecs web-interface (by http). This file describes what type of media is used (G.711 / H.261) and which (multicast or unicast) address the streaming is sent to. The clients (QuickTime and RealPlayer) use this information to listen for the stream.

---

² Note that this document is written with the Basic QuickTime in mind, the Pro version might vary.
Installation and configuration

How to install and prepare codecs for streaming?
The codec must first be installed on the LAN as described in the codec’s user guide, including setting the to DHCP or Static IP assignment, and if Static entering in all the IP fields for address, subnet mask, and gateway.

If 1st time setup of codec:
By default, the codec will be set up with a default Multicast address that is unique to any other TANDBERG codecs, and will most likely not conflict with any other devices if present on the same Ethernet either. This uniqueness allows for having more than one codec streaming on the same network. The default port address will be 22232 for Video and 4 values higher (22236) for audio. The codec setup below is from a codec that is connected to a corporate intranet and is not intended to go beyond any router.

Install a Streaming client like QuickTime, VIC or RealPlayer on the viewing PC, and make sure to install all the required plug-ins as well. Links to these programs can be found on the Streaming web page of the codec or on the following web sites:

Various RTP capable streaming clients
1. For QuickTime: http://www.apple.com/quicktime/
   Whish is a streaming client from Apple Computer Inc. including a plugin for browsers and works very well with codec using SDP. Note that only the Basic version is covered here in this document.

2. For RealPlayer® 7/8: http://www.real.com
   This is a Streaming client that supports RTP/SDP like the above.

3. For VIC: http://www-mice.cs.ucl.ac.uk/multimedia/software/
   The VIC/Rat video/audio streaming clients includes support for Unix architectures.

QuickTime is a trademark of Apple Computer, Inc. RealPlayer is a registered trademark of RealNetworks, Inc.

How to start and end streaming video and audio?

Using Multicast

Starting Streaming
1. Make sure that the PC is connected to the same LAN (or multi-cast enabled WAN) as the codec that is to be streaming
2. Open your web browser (Internet Explorer or Netscape) to the codec’s webpage. Click on the System Configuration Link, and then click on Streaming Settings. Make sure

---

3 Does not support Unicast when using SDP.
4 Please note that Internet Explorer 5.5 has a problem with refreshing the pages correctly and will therefore not work (5.0 works fine, though).
Streaming has started from codec, if not, start it by pressing the Start button or if not allowed to start streaming remotely (Default Setting), then start streaming from codec’s remote control (Menu->Terminal Settings->LAN Settings->Streaming Settings and press green quick key on remote control)

3. To prevent anyone remotely (unwanted or not) to start streaming from the codec during a meeting etc, the menu setting “Allow Remote Start” can be switched off. The setting can be found in the ‘Menu->Terminal Settings->LAN Settings->Streaming’

**Viewing Streaming**

1. Start your web browser and go to the codec’s webpage and the view streaming page by clicking ‘Configuration’, ‘Streaming Settings’, and press the link listed to view the stream. A new webpage is opened with the streaming view displayed within the page. You can also open your web-browser directly to the streaming page by entering this URL into the browser: http://10.0.2.89/stream.sdp where 10.0.2.89 would be the IP of your codec. If a streaming client is successfully installed on the computer, a window will start up and soon show the incoming streamed information
   a. To receive the stream directly from within QuickTime 4 Player, launch QuickTime player, and under the File Menu select ‘Open URL’ and enter http://10.0.2.89/stream.sdp where 10.0.2.89 would be the IP of your codec.
   b. To receive the stream directly from RealPlayer, launch RealPlayer, and under the File Menu select ‘Open Location’ and enter http://10.0.2.89/stream.sdp where 10.0.2.89 would be the IP of your codec.

---

5 Several streaming clients can be installed at the same time, but only one client can be linked to the browser.
c. To receive the stream from a streaming server, launch the server, and under the File menu select ‘Open Location’ and enter rtsp://10.0.2.89/stream.sdp where 10.0.2.89 would be the IP of your codec.

d. To open the stream directly from VIC, launch the VIC player, and enter the multicast address and port address specified for the codecs streaming settings.

2. The audio and video from the real meeting is played with very little delay.

3. A “Streaming” indicator will appear in the left upper corner of the screen to warn the presenter that someone might be watching and hearing. ‘Streaming – Press DISCONNECT to stop streaming’ will be displayed on a streaming TANDBERG 500/1000 codec’s screen.

4. To end the streaming session, just press the DISCONNECT button on remote control or click the ‘Stop Streaming’ icon on the web page provided the ‘Allow Remote Start’ is set to on. If streaming inside a video call, the quick keys will also provide "Stop Streaming" and "Disconnect Call". Note that just closing the web application will not end the streaming session, as other codecs still might be able to receive the streamed information.

Using ‘Unicast’

Viewing a stream via unicast instead of multicast only differs in setup in that the codec must be programmed with the viewer’s IP address before the viewer can actually receive the stream.

From the webpage or from the remote control, enter the IP address of the PC that will be viewing the stream in the address field of the streaming settings page. Be sure that the TTL value is
sufficient to cover the number of network hops between the codec and the viewers IP address (15 or 30 will be sufficient for most setups, including the Internet)

Follow the same steps to start and view the stream as per the instructions for using multicast.

NOTE! If the ‘Allow Remote Start’ of streaming is set and the TV is switched off, there is no visible indication on screen that audio and video is being streamed to whoever streaming at the moment. This must be considered when enabling ‘Allow Remote Start’ of streaming!!

To start streaming from VIC, you have to know both the multicast address and the port address for the stream, it cannot retrieve the SDP file from the codec. The other streaming clients (QuickTime and RealPlayer) must go through the web site of the codec and then click the ‘start streaming’ button there to set up the right SDP file and enable streaming.

Differences between various Streaming clients:
QuickTime\(^6\) can only stream one codec source while VIC and RealPlayer 8.0 can set up more windows if more codecs are streaming to the same address (as opposed to RealPlayer 7.0).

Note. NT4 RealPlayer 7 and 8 have problems with H.261.
Microsoft Media Player does not support RTP (Real Time Protocol).

VIC can listen and connect to any multicast address that might be streaming at the moment. RealPlayer and QuickTime do not allow this, these two programs must have a SDP file (Session Description Protocol file) where an URL is opened to the codec and information about the streaming is retrieved to be able to start viewing the streamed information.

Other streaming clients might not be suitable for streaming from TANDBERG, as they might not support H.261 and/or G.711.

‘Multicast’, what is it and why?
Definition of “Multicast” is only one sender with many receivers. IP addresses between 224.xxx.xxx.xxx and 239.xxx.xxx.xxx are reserved and can be used as user defined multicast addresses. Whichever client wants to listen to information streamed from a codec can listen to a multicast address and receive the information. The addresses in the range 224.2.xxx.xxx are defined for Multimedia conferences, like H.323.

Unicast on the other hand, addresses data to a single address, so only that recipient will receive the data. Unicast is required if you want to stream over a network boundary (router) that does not support multicasting.

If only one client/PC is supposed to receive the streamed information, a Unicast address can be put in the codec’s streaming address (e.g. 10.0.2.250). This means that only the pc at this address can view the streamed information.

\(^6\) Quicktime Pro might be set to open new windows for each stream in the preferences, but is not described here.
For ‘fine tuning’ of the streaming address, the port setting can be set to make sure that codecs sending to the same address can be separated. Video and Audio ports are separate and in the TANDBERG software the default video port address is set to 22232, audio will be +4 (22236). This can be needful to know when setting up firewalls etc.

TTL/Router Hops is a field in the IP header in the packet that tells when a router should drop the packet (Time To Live). The TTL value will be decremented one step every time the packet is about to go through a router (decremented before the packet goes through the router!). The packet will not go through a router when the value has reached or reaches 0.

A router can decrement different values from the TTL depending on router configuration. The setting is helping to avoid unnecessary traffic in and out of a network. Valid TTL values are between 0-127 where the router MUST decrease one value at every router (hop). To ensure that the packet will not slip out of the first router, set the TTL/Router Hops value to 0 or 1.

If blocks occur, just wave your hand in front of the camera to clear up the image. A slow pc will be more exposed to this issue as it fails to get the first refreshed image. It takes from 5 seconds up the 15 seconds from the streaming client starts buffering until it has received a full image, during this period there will be only blocks. The next image will be sent out after a short while and clear up the image.

Using a TANDBERG system on a corporate LAN conferencing a remote system over ISDN is a useful application.
Frequently asked Questions about Streaming.

Streaming

What is ‘Streaming’?
Streaming is a technique for sending audio and video data from one videoconferencing system to one or several PC’s. Rather than having to wait a long time to download data, recipients can watch audio and video from the videoconferencing systems in real time, right from their own desktops.

What are the benefits of streaming?
A number of people can listen in and participate in a meeting they physically can’t go to. The participation is however one-directional and allows the participant to see and hear whatever discussed. This way a huge number of people can be invited to listen to e.g. a company speech etc.

Can I record a meeting and look at it later?
If the videoconference is recorded (using a streaming server), then the recipient may also replay the videoconference or view it at any other time that is convenient.

What is ‘TTL/Router hops’?
TTL/Router Hops is a field in the IP header in the packet that tells when a router should drop the packet (Time To Live). The TTL value will be decremented one step every time the packet is about to go through a router (decremented before the packet goes through the router!). The packet will not go through a router when the value has reached or reaches 0.

What is the ‘Port Setting’ in the menu?
For ‘fine tuning’ of the streaming address, the port setting can be set to make sure that codecs sending to the same address can be separated. The port setting is normally set depending on which service in use (web, mail, telnet, ftp etc.). The default codec value is set to 22232.

What is ‘unicast’?
If only one pc is supposed to receive the streamed information, a Unicast address can be put in the codec’s streaming address (e.g. 10.0.2.250). This means that only the pc at this address can view the streamed information.

What is ‘multicast’?
Definition of “Multicast” is only one sender with many receivers.

Why does the old multicast address remain and not the new after an upgrade to B2 (or later) software?

7 Please check with IP literature for a more detailed explanation on various IP concepts, these explanations is of a general matter.
From B2 software and newer, will the codec create a unique multicast address per codec the first time it is booted after an upgrade (or restore defaults has been issued). However, if upgrading software from B1 may the upgrading software save the old settings and then restore them after codec has been booted and thus over-write the uniquely created multicast address with the old defined for B1.

Why “Service not available. Disconnected” when trying to start a call while streaming?
Please upgrade your system’s software to B2 software or higher. Streaming while in a call was previously not supported.

Why “Cannot start streaming while in a call” when pressing “Start Streaming” while in a call?
Please upgrade your system’s software to B2 software or higher. Streaming while in a call was previously not supported. TANDBERG 500 and 1000 cannot stream outside a call.

Why do I get stream from the wrong codec?
When several codecs are streaming on the same LAN, it might be arbitrary which one will turn up in your client unless they have different streaming addresses (and or ports). Basically there is nothing wrong with several streaming sessions to the same address, but few clients can handle this (only Vic/RAT?). So e.g QuickTime will choose one at random. The solution is to change the default settings on the codec. A "numberplan" like replacing the last number in the streaming address to the codec's last byte (e.g. if codec's IP address is 10.0.3.38, change stream address to 224.2.17.38) will in most cases solve this.

Streaming clients

Which streaming clients do TANDBERG streaming support?
TANDBERG recommend QuickTime, RealPlayer 8.0 or higher and VIC.

Where can I find the recommended streaming clients and what do they cost?
The following RTP capable Streaming clients are all freeware

1. For QuickTime: http://www.apple.com/quicktime/
   Which is a streaming client from Apple Computer Inc. including a plugin for browser and works very well with codec using SDP

2. For RealPlayer® 7/8: http://www.real.com
   This is a Streaming client that supports RTP/SDP like the above.

3. For VIC: http://www-mice.cs.ucl.ac.uk/multimedia/software/
   The VIC/Rat video/audio streaming clients includes support for Unix architectures.

QuickTime is a trademark of Apple Computer, Inc. RealPlayer is a registered trademark of RealNetworks, Inc.
What do TANDBERG require from the streaming clients?
The TANDBERG codec require any streaming client that can handle H.261 video and G.711 audio. Further must RTP and either direct entry of Streaming address or SDP be supported. Streaming clients that support these standards can all theoretically be used, although VIC, RealPlayer 8.0 or higher and QuickTime are tested and recommended streaming clients.

How to set up the streaming client, what do I have to do?
Please see the installation section above.

Can I start streaming directly from the streaming client?
This is only possible with VIC (where the Streaming address and the port address must be known) and not with RealPlayer or QuickTime, these two clients require the SDP file to be loaded first.

Can I have more than one streaming client installed on my computer at the same time?
It is ok to have both RealPlayer and QuickTime installed on your computer at the same time, but only one (either the first-installed or the last-installed client, depending on the settings and links to type of software when installing) will run in a web page. It is possible to receive the stream manually from the Program menu by choosing "Open URL"/ "Open Location" and type in the address to the SDP file on the codec (e.g http://10.0.2.89/stream.sdp).

Can I stream from several codecs to the same Streaming client?
VIC and RealPlayer 8.0 can set up more windows if more codecs are streaming to the same multicast address (QuickTime Pro might be set up for multiple streaming windows, not described in this document)

Can I stream to multiple unicast addresses?
Not from within the codec itself. The codec will only support 1 unicast address to send data to. If you want multiple unicast destinations (like multiple viewers over the Internet) you must setup a reflector. A reflector takes a stream from a source, and then can ‘reflect’ it out to many clients without having to actually take more streams from the original source. An example of a reflector would be Apple’s QuickTime streaming server, or Apple’s Darwin streaming server. Both servers can take a unicast or multicast source, and reflect it out to an unlimited (limited only be processing power, memory, and bandwidth) number of unicast or multicast clients. See http://www.apple.com/quicktime/products/qtss/ for information on Apple’s streaming servers.

Why can’t I receive streaming with Internet Explorer 5.5?
You will experience problems receiving the stream if you are using Internet Explorer 5.5. There is a problem with refreshing the pages in this version and therefore will the stream not be received correctly. Please change to another browser e.g Internet Explorer 5.0 or Netscape.

I have problems using a unicast address with RealPlayer.
The multicast part of the RealPlayer must be enabled even though a multicast address is not used to make it work with SDP files/URLs.

To do this:
Select View->Preferences->Transport and select the "Use Specified Transports" button. Click on "RTSP Settings" and select "Use TCP to Connect to Server" and hook off "Attempt to use Multicast for live content". Press OK. Do the same for "PNA Settings" on the Transport page. Please note that this might be in conflict with "normal" use settings...

**Video**

**What will I see and hear when I stream from a Videoconference?**
This depends on the Streaming setting set on the codec you are connected to. The steamed video image can either be the outgoing image (the selfview image of the codec you are connected to), the incoming image or a combination of both, where the image from the current site speaking (local or far end), will be streamed out. The local codec will have a ‘Streaming’ indicator in the left upper corner on the screen while the TANDBERG 500/1000 will display ‘Streaming – Press DISCONNECT to stop streaming’ on screen to remind them.

**Why do I get blocks when I start streaming on my streaming client?**
A slow pc will be more exposed to blocks when streaming as it fails to get the first refreshed image. The next image will be sent out after a short while and clear up the image. If blocks occur, just wave your hand in front of the camera or move the camera to clear up the image.

**Why don’t I get anything shown on my streaming client?**
When starting the streaming client, it just spools and nothing appears in the streaming window. Make sure that the codec actually has started to stream, if not, please start it. If nothing is streamed from the codec, then the client will not receive anything and thus the window will be empty.

**Why does QuickTime connect and just say ‘ready’ and I get no video or audio?**
The actual streaming data is not receiving the information from the codec, even though the connection is opened. If you are using a multicast address, the network may not be passing the multicast information across network boundaries, or try increasing the TTL value if you are across a large multi-cast enabled network. If you are using a unicast address in the codec, be sure you have the proper viewer’s IP address set in the codec’s streaming settings, and increase the TTL value if you have numerous network hops between the viewer and the codec. The distance between the viewer and codec can be examined by using a traceroute utility.
Why is the streamed image frozen?
On B1 software: If streaming is stopped and restarted the client will not re-establish (i.e. it seems to be frozen.) This is related the clients inability to view more than one streaming session at the same time as a re-start will appear as a new streaming session. Thus for those clients capable of only showing one session at a time, they will display the last received image of their current session. The solution is to reload the streaming page/reconnecting the client with the stream. This should not be any problem after B2 software.

Audio
I don’t have lip sync when I stream! What is wrong?
Lip-sync problems may occur occasionally, at the moment there is no standard to handle this issue. Video and Audio are streamed in two separate streams and this is why the problem may occur from time to time. The issue is also client specific and will vary depending on which streaming client in use.

No Audio
A possible explanation is that another program has "stolen" the audio device. I.e. on PCs running Windows only one program may play a sound at a time. Thus, if a client, another streaming client or perhaps a browser with a Flash script playing music is running, the stream client will not play the audio from the stream.

Security
Can I know who is receiving the stream from my codec?
There is no way to tell who or how many participants that are streaming from the codec. The local codec will have a ‘Streaming’ indicator in the left upper corner on the screen (the TANDBERG 500/1000 will display ‘Streaming – Press DISCONNECT to stop streaming’) to remind them they are streaming. The same message is displayed is streaming was started either locally from the remote control or remotely if ‘Allow Remote Start’ is set to ‘On’.

How do I prevent anyone from receiving the stream from my codec?
Set ‘Allow Remote Start’ denies anyone to start streaming from codec, but cannot select the audience.

How do I control who will be receiving the stream from my codec?
Users will normally have to log onto the codec’s web page to retrieve the SDP file. Denying the access to the web page by issuing a IP password will prevent them to retrieve this SDP file and thereby deny them to receive the stream. Set the IP password and give this only to the ones who are allowed to participate. Change this password frequently as well as the Streaming address (and port) and let the participants know the new parameters before every meeting. Note, that with VIC,
only knowing the Multicast address (the streaming address) and the port address will be enough to start receiving the stream!!

**How do I control who will be receiving the stream from my codec II?**
Please see “Can I stream to multiple unicast addresses?” question above about setting up a reflector and then stream to several unicast addresses.

**How can I deny someone to receive the stream from my codec?**
It is not possible to ‘throw’ out selected recipients once they have first connected and started to receive the streaming. To avoid such a situation, give the IP address and IP password to the invited people only, or if just one viewer, put in the IP address of that particular PC as a unicast address and no one else can receive any streaming from that codec.

**How to set Streaming Password?**
IP password to log onto the codec can be set by a dataport command through a terminal program. Please see ‘TANDBERG Dataport User Guide’ for assistance.

**How many can receive the stream from my codec?**
If a Multicast address is set as streaming address, then virtually an infinite number of viewers can listen, if a Unicast address is set, then only that one pc can stream.

**How do I stop streaming?**
To end the streaming session, just press the DISCONNECT button on remote control or click the ‘Stop Streaming’ icon on the web page provided the ‘Allow Remote Start’ is set to ‘On’. If streaming inside a video call, the quick keys will also provide "Stop Streaming” and "Disconnect Call". Note that just closing the web application will not end the streaming session, as other codecs still might be able to receive the streamed information.
More stuff on Streaming

Background
Streaming is a technology that allows multimedia (audio/video) to be transferred and viewed in real-time over a packet-switched network like an intranet or the Internet without the use of downloading complete files. When explaining how streaming works, it is important to first understand how multimedia (video and audio etc.) is transferred without the use of streaming.

The traditional approach to view multimedia on the Internet was to download the entire file before playing. As most everyone knows, multimedia files on a computer are big. Even a tiny movie with jerky movement and bad sound easily fills up megabytes on a computers hard drive. If you want TV-quality movies, the resulting files are enormous. Clearly, downloading time also becomes too long to be of any practical use.

Streaming is a relatively new Internet-technology, which is addressing this problem. VIC/VAT/(rat) was developing the technique in the early 1990s but only on a non-commercially level. It was first being commercially demonstrated by Progressive Networks (now Real Networks) in April 1995 when they launched their RealAudio player. With this tool it was suddenly possible to listen to music and other audio on the Internet without downloading entire files. Instead, audio was continuously downloaded and the audio was played as the data reached the computer. This also opened up the possibility for audio broadcasting on the Internet.

The first version of RealAudio became very popular even though sound quality was poor, and soon radio stations all over the world had started broadcasting over the Internet. Progressive Networks released within months of the first release upgrades to the program that made the sound more appealing and also supported higher bandwidths. Two years later, in early 1997, Real Networks announced RealVideo along with a new all-in-one audio/video client called the RealPlayer. Dozens of web sites like Virgin, MSNBC and ABC immediately jumped to the RealVideo system and started transmitting live and pre-recorded material from their web sites. A lot of other companies are also offering streaming technology now (like QuickTime, VIC, Microsoft MediaPlayer and so on).

Technology
Packet-switched networks
So, how does streaming work, then? First a little technology primer: The Internet and intranet are so-called packet-switched networks, which means that data from a server (the codec) is sent out in small chunks, called packets. Each packet is passed through the network from node to node along some path leading from source to destination. At each node, the entire packet is received, stored briefly, and then transmitted to the next node. The path from source to destination may vary from packet to packet and therefore also the transmission time for each packet. There is also a risk that packets will be lost on the way from source to destination, in which case the packet has to be retransmitted.

This is very different from traditional circuit-switched networks where a dedicated communications path is established between two stations through the nodes of the network. Data generated by the
source station are transmitted along the dedicated path as rapidly as possible. At each node, incoming data are routed or switched to the appropriate outgoing channel without delay. The best example of circuit switching is the telephone network.

**Transferring multimedia on the Internet**

The Internet was designed for transferring computer data, not real-time audio and video, and for that purpose packet switching is ideal. It is a very bandwidth-efficient technology and it is ideal for cheap data transfer over large distances. When downloading traditional data, a network delay is of no big importance. If a packet gets lost on the way, it simply means that the file will be ready for viewing a little later. Real-time multimedia transfers on the other hand depends highly on a synchronous network that delivers the data to the receiver as they were sent from the source, and of course with as little delay as possible. This seemed to be impossible to combine with packet-switching and the traditional method of transferring multimedia was therefore to download the entire multimedia file before viewing it to be sure that all packets was received and in order before viewing.

Streaming multimedia on the other hand plays as it downloads. The secret behind this is buffering. The multimedia file is first converted to a format suitable for streaming. Then it is split into packets before transferring like any other types of data that are transferred on a packet-switched network. When the receiver gets the first chunks of data it holds the data until a certain amount of it (say 10 seconds of play-time) is received. It then starts playing the data. While it is playing, more data is received continuously as the packets arrive and fills up the buffer. Because the incoming data is not subject to playing right away, some delays and data shuffling may be accepted. The computer has time to reorganize the data and even request missing data before the buffered data has been played.

**Bandwidth and multicasting**

A key issue in streaming is bandwidth. Clearly, a picture stream with a higher data rate than what the actual bandwidth to the computer can handle, will cause the buffer to be emptied faster than the incoming data can fill it up. Therefore it is important that the data stream is compressed enough to ensure that the receiver can handle the data rate. Two very important factors here are picture size and frame rate. Reducing them will dramatically reduce data rate and along with sophisticated compressing algorithms, this makes it possibly to view live video even over a 28.8 Kbps modem connection.

When using streaming on a corporate intranet, focus changes. Because of the high bandwidth available, typically 100Mbps (or 10Mbps), full-screen, full-motion video is possible to achieve. There are other things to worry about, though. To get high quality video, streams with a data rate of several hundred Kbps is required. It is of great importance that the streaming data being sent over the network don’t interfere with the rest of the network applications. It should run alongside all the other regular traffic without slowing it down. A typical 10Mbps LAN would suffer from congestion already at 20-30 streams of such quality. And that is without all the regular traffic. This means that unicasting (each computer gets its separate stream from the server) is not a very good solution. The answer is IP multicasting.
IP multicasting sends a single stream of data to those clients who request it. Multiple copies of the same data are not sent across the network, nor is data sent to clients who don’t want it. Multicasting follows a push model of communications. That is, like a radio or television broadcast, those who want to receive a multicast, tune their sets to the station they want to receive. In the case of multicasting, the user is simply instructing the computer’s network card to listen to a particular IP address for the multicast. The computer originating the multicast does not need to know who has decided to receive it. Therefore, the load on the server sending a multicast stream and the network transporting it, is the same whether 1 or 1000 is receiving the stream.

**Network protocols**

In the wake of streaming technology, network protocols have appeared to better control streaming multimedia.

- **RTP - Real time Transport Protocol.** This is an emerging standard for sending real-time multimedia data. For one thing, it allows for timestamping of the media packets sent. Thus, streaming systems featuring RTP allows for better time-identification of the packets sent. This also makes it possible to “fast forward” or rewind in a media stream, almost like a VCR.

A final word also about the UDP (User Datagram Protocol); Almost all streaming software on the market prefers this protocol for the actual delivery of data in preference to the elsewhere more common TCP. This is because UDP, as opposed to TCP, do not feature packet control mechanisms. Thus, a packet may be lost while transferring data and the network have no way of requesting resends. In streaming systems, it is more practical to let the client to this task. This also reduces the server load. Also, by reducing overhead data (as packet control mechanisms is) in packet transmission, more media data may be sent on the actual bandwidth.